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1.1

1.2

1.3

1. Navigation

This document provides an overview of the basic template, navigation, common operations
that can be performed, and keyboard short cuts available in Oracle Financial Services
Lending and Leasing. Since this section details the general options available in the User
Interface, some or all the parts of this section are applicable to you as per access provisions
& licensing.

The document is organized into below topics:
e Logging In
e Template and Navigation

e Common Operations
e Hot Keys

Note

The application can be best viewed in 1280 x 1024 screen resolution.

Audience

This document is intended to all Prospective Users who would be working on the application.

Conventions Used

Term Refers to

The system/application Oracle Financial Services Lending and Leasing

Mnemonic The underlined character of the tab or button

Logqging In

The pre-requisites to log into the system are a valid user ID and a password, defined by the
system administrator in Administration > User screen.

You can login to the system using a valid user ID and a password defined by the system

administrator, in Administration > User screen. A User ID is disabled automatically by the
system if it is inactive for a specified number of days.
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When you invoke the application, the Sign In screen is displayed.
opacLe: B O

Financial Services Lending and Leasing

sign In
Please enter userid and passviord

*User1d

Password

e User ID — Specify a valid User ID.
e Password — Specify a valid password for the specified User ID.

The system accepts the User ID and password in upper case only. After specifying valid
credentials, click Sign In to sign into the application.

1.4 Template and Navigation

This section provides a brief input on the template and navigation of the system. Details are
grouped into two categories to enable easy understanding. These include:

e Home screen
e Screens

141 Home Screen

Once you login to the application with valid credentials, the system authenticates the details
and displays the Home screen.

The Home screen consists of the following components:

e Header
e Left Pane
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e Right Pane/Work Area

ORACLE" B vATDYA iy S
Financial Services Lending and Leasing

 Origination
> Servicing
> Collections
 WFP

> Tools

> setup

You can view the application version details and copyright information by clicking About link
at the right corner of the screen.

reement or allowed by lav, you may ot use, copy, repr
in any form, or by any means. Reverse engieering, d

be errorfree. Ifyou find any errors, please reportthem o us i wrting.

behaf of the U.S. Government, the follwing notice s

Header
In the Header, system displays the following:

e User ID that you have currently logged/Signed in. Click the adjoining drop-down arrow,
the system displays the following options:

Y Accessibility ESneE <~

Change Password

m  UserInfo 3]
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Change Password — Click to change the current password.

ORACLE. . G o]

Specify the current password in the Current Password field and a valid password,
you wish to maintain as a new password, in the New Password field. Re-enter the
password in Confirm Password field and click Submit to change the password.

User Info — Click to view the current user info.

Oracle Financial Services Lending and Leasing ®
User Info
Organization DMC Time Zone |JSER TIME ZONE ¥
Division US01 Level
First Name VARSHA User Time Zone UNDEFINED
Last Name VAIDYA Company US/CENTRAL (CENTRAL STANDARD

Branch Time TIME)
Responsibility SUPERUSER S

GLFost Date 02/10/2016 Server Time  ASIA/CALCUTTA (INDIA STANDARD
Last Login Date 02/10/2016 03:21:07 AM Zone TIME)

Session Language DEFAULT v Skin Family Skyros (Default) v
Debug Enabled Ind

|_—|5 Submit 7% Close

In this screen, apart from viewing the user info, you can also set Session Language,
enable error log, and specify the time zone preference.

Session Language — Select a language that you need to set for the session, from
the drop-down list.

Debug Enabled Ind — Check this box to enable the debug indicator.

On selection, system records all the debugs into logs files depending on the
following two types of system parameters:

System Parameter Condition to record debug data

CMN_DEBUG_METHOD If parameter value is 1, then debug data is
recorded into a file in Database Server.

If parameter value is 4, then debug data is
recorded into the table LOG_FILES HEADER.

CMN_DEBUG_LEVEL If parameter value is greater than 0, only then the
debug data is recorded.

The debug data can be viewed from Dashboard > System Monitor > Database
Server Log Files.

You can click on = List Files button to view the list of logged files.
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ORACLE’
Financial Services Lending and Leasing

DashBoard 3 System Monitor [3] Close
Batch Jobs = Jobs | Services Database Server Log Files  Parked Transactions | Users o~
Database Server Log Files
View v Format~ Freezz i Detach Wrap W) :=Svstries [ Download File
File Name File Type File Size File Time
JSVPRC_EN_000_01 DB12C_2084400 fob 5706 02/18/2016 06:14:11 A) »
ALERT lob 395 02/22/2016 03:59: 15 A_|
CSYPRC_EN_100_01_DB12C_3794335 lob 6390 02/22/2016 04:53:00 AP =
CSVPRC_EN_100_01 DB12C_3854338 lob 116750 02/22/2016 05:36:42 AP
IJSVPRC_EN_000_01_DB12C_2004362 lob 5706 02/18/2016 10:57:09 Al =
P - ‘ .
v
File Content
View * Format v Freeze  CfiDetach ol Wrap B} ©Begring@End #oflines 50 [E] Show File
Text i
0
o :11: cmnsyp cl 000 Ol.get syp parameter value value: weblogic
0

:11: 45:FLL:1v_use BI::Y [

:11: cmnsyp cl .get_syp parameter value value: http://ofss2221142.in.oracle.com:.

.get_syp_parameter_value valus: http://ofss2221142.in.oracle.com:

111: cmnsyp_

t11: cmnsyp cl 000 _Ol.get syp parameter valu : JSV_BI_USER
¢ J5V_REPORT_ARCHIVE_DIRECTORY
:11: cmnsyp_cl_000_0l.get_syp parameter value parameter: JSV_REPORTS_SERVER TIMECUT

:11: cmnsyp_cl 000_Ol.get_syp parameter value value: /scratech/work area/DEV/QA14SREL/r. |~
:11: cmnsyp cl_000_0Ol.get_syp_parameter_valus parame

o oo oo

Click on & Show File button to view the selected file contents in the ‘File Content’
section. You can also click & Download File button to extract a copy of debug
details.

Time Zone Level - Select the time zone preference as User/Company Branch/
Application Server Time Zone from the adjoining options list.

For more details on time zone selection, refer to Time Zone Preference section of
this user manual.

Click Submit to save the changes or Close to close the screen without changes.
Accessibility — Click the link to view accessibility features of the system.
Refer accessibility document for further details.

Sign Out — Click the link to sign off from the application. You can also click on
icon to sign off from the application.
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Left Window

In the left pane, system lists and provides drop-down links for various modules available in
the product. Click 2/ to expand the Module Master Tabs and ¥ to collapse them.

> DashBoard
> Origination

Servicing

[Esenicing
Customer Senvice
Securitization
Transaction Autherization
Post Date Checks
Escrow Transactions
Account Documents
Collateral Management
Reports
Producers
Vendors

DEatch Transactions
» Mnterfaces |

»» Collections
> WFP

> Tools

» Setup

To open a screen, navigate to Module Master Tab to which the screen belongs, expand the
tabs, and click the screen link you wish to open.

Right Window

The Right Window can also be termed as work area. When you click the screen link on left
pane, system displays the corresponding screen in the right pane.

ORACLE
Financial Services Lending and Leasing

% Welcome, VAVAIDYA +  pccessioiry  NSNRIGE =

12/08/1987

> sarviang
> Collections
> wep
> 1o0ls

> Setup

You can open a maximum of 15 screens at a go. Once the maximum limit is reached, the
system displays an error message.

In origination, only one among the three screens namely, Application Entry, Underwriting,

Funding can be opened at a time. If ‘Application Entry’ screen is open and you click on
Underwriting or Funding, the system retains the same screen.
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ORACLE"
Financial Services Lending and Leasing
5

2 Edt || Blview || 2 avsie

i petach

S Feror o . :
2012 1000010580, BROWIY PALL/ PAULA 02/09/2015 crianceD orF cRroR VeRoUTH 02/09/2015 UNDEFNED
20100100014000:000 SULGAN c2/0a/2010 Criareco orr chror VeRouTIL o2/0v/201c UNpErIED
Parameters
- Fomare B Llreee ) vetach wee | @
Parametes Velus Srriz
THOATE osiosr0te v

4 Transaction processing Detalls

[PRe— 8 vetacn wee | @

> Collections.
> wrp.
> Tools

> sctup

Each active screen is displayed as a tab at the top of right pane, across its width. To view a
screen, click the screen tab. You can identify the active screen with its white background.
Also, operation on any of the screen will not affect the data in other screens.

Right Splitter/Action Window

The Right Splitter/Action Window has quick access to search and other options to avoid
switching between tabs or navigating into sub tabs periodically. You can access the Right
Splitter/Action Window while working on an Application or Customer Service screens. You
can click ﬂ and |: to toggle the view of Right Splitter/Action Window.

Origination Screens

In Origination — Application screens, you can use the Right Splitter/Action Window to do the

following:

ORACLE’ i & Welcome, VAVAIDWA ~  ccessibily - [ EOIIGE] O
Financial Services Lending and Leasing

rigination Close
> DashBoard Originatis &
Fr—— Search/Task | Funding: 0000000378 | Review Requests (Pending: 0) )
L Quick Search
o
Application: 0000000378: TIFFANY RUSSEL / GRACE B view || &2 audt o
Vieww Format~ B 1] Freeze i Detach wap | @) OvemdeOK ¥ WamingOK ¥ =
Y oo dentification
Underviriting " . = Origination Stage Duplicate %
o oo Sub Unit Status Ot Producer Name Co Bistng Customer  DUNALE Contact
I [ submt | @ clear
01/01/2012 0000000378 UNDEFINED /APPROVED - FUNDED FUNDED GA-00004 : ADVANCE LEA. N N
» Summary
Requested  Approved
Advance 150000 1500000
Summary Applicant = Request Decision Contract Collateral ~Comments Tracking Document Verification —Correspondence Tools Fate 89900 43900
Term 36 3
> Applicant Grade  DGRADE Score 0
v s
Stated PTI054
! Mt Book 10,000
2012 CHEVROLET MONTE CARLO
5 8
> Bureau
Quese FUNDED APPLICATIONS QUEUE
] Change Status
Collateral
Collateral Add Comment
Asset Type subType Primary  vear vake Vodel Mileage New Whalesale Value G
> Servicing VEHICLE car ¥ w2 cHEVROLET MONTE CARLO on 1000000 Bl
> Collections Tvpe A
N “sub -
CAWER) Trade-In Tive
> Tools * Comment
& Sebup Trade-In v E

e Use Quick Search to search for an application based on application number, last 4
digits of SSN (SSN of the primary applicant) or identification number. If multiple
applications or accounts are found during ‘Identification # search, the system displays
an error message as “Multiple Matches found for the Identification #, Please use normal
Search”.

e Summary section displays critical information that has to be referred repeatedly during
origination like — DTI, PTI, Book Value, Grade, FICO Score, Approved Advance, Rate
and Term.

e Use Change Status section to change the application status to next level. If the
application edit status is restricted, then the ‘Change Status’ will be read-only.

e Use Add Comment section to post an alert or comment during Underwriting and
Funding stages.
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For detailed information on the above options, refer to respective sections in the
document.

Servicing and Collection Screens

In Servicing and Collection — Customer Service screens, you can use the Right Splitter/
Action Window to do the following:

ORACLE"
Financial Services Lending and Leasing

3 Welcome, VAVAIDYA ~  accessibilty [=)

ustomer Service x (3] Close
> DashBoard CLEAmeEr S8 L]
> Origination | © 0} =
L Quick Search
Servicing N
e Account(s): 20120200010231: YUTAKA OZAKA / AKANE Ewew || 2 aust
Vieww Fomat~ P ] Frecze i Detach o @ G © curent © showall O Group Follov-up
Company Eranch Sub Unit Days Past Due Currency
usor use1 UNDEFINED 2012020010231 LEASEVEHICLE 0 UsD
[B submit | | & Clear
Summary | Customer Sendce | Account Details || Customer Details || Transaction History | Pt Modes || Bankruptcy | RepojForeclosure | Deficiency | Collate > ~
Collateral Management QueiniSenduen
Repo Alerts Conditions i
unt
Alerts Conditions
Alert start ot Followup Dt
o data to display. LIEN DATA CHANGE 02/10/2016 02/10/2016
Account Details Other Information
4
Dues Collateral Information 12 ey Wi e
01/10/2015 12102014 14102084 10/10/2084 Description Ientification = Vear  Asset Class _
000 o0 000 000 2012 MERCEDESEXO04DR  2GWSS2ISILA0RL 2012 NEW Add call Activity
Delq Due 0.00 Total Due 0.00 Future Pt 02/10/2015 A =
elq Due otal Due uture Pt 02/ s
e e 000 ’ Customer Information Result .
1i5F Due 000 Gldast Due: 0c/10/2013 | |REREE e Relation ssh Contact i
QD B Amt paid 0.00 000000... OZAKA A YUTAKA PRIMARY a3t Z]
Excess D00000... AKANE B YUTAKA SPOUSE  eonocs 3399
Pay »
Delinquency Information <
£ 20 1m0 1 Email MARIEC@SSC.COM v
o 0 ) o 0 0 ) Language ENGLISH
tal By
ep(life) 0 NSF(Life) 0 Collector GIRI Status Coresp n .
s Bp(Year) 0 NsF(vear) 0 [
> wep e AMERICA NN A postcallacy | | @ clear
> Tools Woy2  App 000000 L
> Las 12/24/2045  paid Off ot ch .
> Setup el i Address Information =
Copyright © 199 2016, Oradle andjor s affates. Allights reserved “about

e Use Quick Search to search for an account based on account number, or customer Id,
or last 4 digits of SSN (SSN of the primary applicant) or identification number. If multiple
applications or accounts are found during ‘Identification # search, the system displays
an error message as “Multiple Matches found for the Identification #, Please use normal
Search”. You can also select the Queue Condition and Auto Run options during search.

e Use Add Comment section to post an alert or comment based on Type and Sub Type.

e Use Add Call Activity section to post all types of call activities including promise to pay,
account conditions and so on, irrespective of the screen you are working on. This is
similar to the option available in ‘Call Activities sub tab’ under Customer Service tab.

For detailed information on the above options, refer to respective sections in the
document.

The height of Header and width of the Left and Right Panes do not change, with resizing of
application screen.

The system facilitates toggling Header and Left and Right Panes of the home screen to
increase the visible area of the screens. Click ==u to toggle upper pane and j to toggle left
pane. To un-toggle click /= and |: respectively.

Few screens in Origination, Servicing and Collection are identical and are linked. Hence, you
can open only one screen at a time from the group. A sample of the grouping structure is given
below, based on stages of the screens:

Origination:
e Simple Application Entry
e Application Entry

e Underwriting
e Funding

Collection:
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1411

e Collection

e Bankruptcy

e Repossession
e Deficiency

WFP:

e Producers

e Credit Lines

e Units
As per the above listing, you will be able to open only one screen in the corresponding listi.e.
if you have opened the ‘Application Entry’ screen in ‘Origination’, you are not allowed to open
any of the other 3 screens until you exit the ‘Application Entry’ screen.

Time Zone Preference

Oracle Financial Services Lending and Leasing *
User Info
Organization DMC Time Zone (JSER TIME ZONE v
Division U501 Level
First Mame VARSHA User Time Zone  UNDEFINED
Last Name VAIDYA Company US/CENTRAL (CENTRAL STANDARD
) A Branch Time TIME)
Responsibility SUPERUSER D 10K
6ot Date- A0 07201 Server Time ASLA/CALCUTTA (INDLA STANDARD
Last Login Date  02/10/2016 03:21:07 AM Zone TIME)
Session Language  DEFALLT X Skin Family  Skyros (Default) v

Debug Enabled Ind

E@éuhmit 4 Close

You can select any of the following three time zones from the User Info screen:

e Application Server Time Zone
e Company Branch Time Zone
e User Time Zone

The time zones set up at each of these levels are displayed in the user info screen. However,
data is always stored in the application server time zone and based on the user preference of
time zone, the display time would be User or Company or Application Server time zone. Any
time zone related changes done at Ul does not impact the other time bound activities which
are dependant on database time.

Application Server Time Zone (Server Time Zone)

The Application Server Time Zone by default is the Production Server Time Zone. Selecting
this time zone will have all date and time fields defined as per the time stored in application
server. There is no offset in time if both storage (database server) and display (application
server) are in the same time zone.

Company Branch Time Zone (Organization - Division Time Zone)

This is the Company time zone and is setup at the organization - division definition level. The
various divisions defined under an organization can be set up with different time zones
depending on geographical locations. This time can be modified as per requirement.
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1.4.2

1.5

To modify the Company Branch Time Zone:

e Navigate to Setup > Administration > User > Organization and select the company or
division listed under 'Division Definition'.

e Inthe Display Formats tab, select Time Zone and click ‘Edit’.

e Inthe Format field, select the required time zone from the adjoining options list and click
‘Save’.

If'Company Branch Time Zone'is selected as the time zone in User Info screen, then on save,
all the time and date fields are automatically updated with the time zone of the company
branch.

User Time Zone

User Time Zone or User Preference Time Zone can be set up at the User Level in the User
Definition screen. Various Users under same divisions defined under an organization can be
set up with different time zones depending on geographical locations.

To modify the User Time Zone:
e Navigate to Setup > Administration > User > Users.
e Select the required User record listed in “User Definition” section and click Edit.

e Inthe Time Zone field, select the required time zone from the adjoining options list and
click Save.

If 'User Time Zone' is selected as the time zone in User Info screen, then on save, all the time
and date fields are automatically updated with the current updated time.

Screens

Details in few main screens are grouped into different sections. These sections are displayed
as tabs, horizontally within the screen. In turn, details in few of these tabs are again grouped
horizontally. The details are displayed when you click the tab under which they are grouped.
As similar to the main screen tabs, you can identify the active tab with its white background.

For example, Customer Service main screen has four main tabs. When you click on
‘Customer Service’ tab, the corresponding tabs are displayed.

Customer Service x Mcho
‘ Search  Customer Service: 20120200010231  Review Request (Pending: n)‘
Account(s): 20120200010231: YUTAKA OZAKA |/ AKANE Elview | o Audt
Vieww Formatv Freeze i Detach ap | B B @ Curent O showAll O Group Follow-up
Company Branch Sub Urit Account # Product Days Past Due Currency Pay OFf Amt Amount Due Status Oldest Due Dt
Us01 UsR1 UNDEFINED 20120200010231  LEASE VEHICLE 0UsD. 0.0 0.00 ACTIVE 02/10/2015
‘ Summary | Customer Service | Account Details | Customer Details | Transaction History | Pmt Modes | Bankruptcy | RepojForeclosure | Deficiency | Collateral | Bureau C\nz:,‘LpSe\Mrt\\,'\tiez‘
‘ CGall Activities | Maintenance Comments Promises | Checklists Tracking Attributes | References Correspondence | Letters  Document Tracking
Call Activities qpadd || ZEit | [E]view | of dudit
View= Formatv [ Freeze ] Detach Wrap ®
Action Result Contact Reason Cancel Promise Dt Promise Amt Condition Appointr Follovup Dt Time Zone Adj Folloviup Dt Conr
AT PH ANSWERING MACHINE ] 12/30/2015 1,000.00 NONE N 1202015 12/29/2015 12:30:00 P}

AT PH ANSWERING MACHINE N 12302015 1,000.00 NONE N 12/30/2015 12/29/2015 12:30:00 PM
»

You can click # to view the hidden tabs, if any.

Common Operations

Some of the operations are common to most of the screens. These are grouped into three
categories, based on their features.
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e Basic Operations
e Basic Actions

e Personalization Options

Basic Operations

All the screens contain buttons to perform all or few of the basic operations. The four basic
operations available are:

e Add
e Edit
e View
° Audit
¢ Add || S Edit

E] view | < Audit

When you click any of the operation tabs, system displays the corresponding records inline,
below the respective setup tables.

The table below gives a snapshot of them:

Basic Operation

Description

Add

Click to add a new record. When you click Add, the system displays
a new record enabling you to specify the required data. It is
mandatory to specify details for the fields marked with “*’ symbol.

Edit

Click to edit an existing record. Select the record you want to edit
and click ‘Edit’. The system displays an existing record in editable
mode. Edit the required details.

View

Click to view an existing record. Select the record you want to view
and click ‘View’. The system displays the record details in display
mode.

Audit

Click to view audit info. If an audit is set for a field, then the system
tracks the changes for that field. Select the record for which you
want to view the audit info and click ‘Audit’. The system displays the
details tracked for that field.

Close

Click to close a screen or a record. When you try to close an
unsaved, modified record, then the system alerts you with an error
message. You can click ‘Yes’ to continue and ‘No’ to save the
record.

Basic Actions

Most of the screens contain buttons to perform all or few of the basic actions.

All or few of these actions are enabled when you select any of the Basic Operations.

4 save and Add

[ save and stay

[ save and Return

<3 Return
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The table below gives a snapshot of them:

Basic Actions Description

Save And Add Click to save and add a new record. This button is displayed when
you click ‘Add’ button.

Save and Stay Click to save and remain in the same page. This button is displayed
when you click 'Add/Edit' button.

Save And Return Click to save and return to main screen. This button is displayed
when you click ‘Add’ or ‘Edit’ buttons.

Return Click to return to main screen without modifications. This button is
displayed when you click ‘Add’, ‘Edit’ or ‘View’ buttons.

The summary screens consist of the following navigations. The table below gives a snapshot
of them:

Basic Actions Description

Click to navigate to the first record.

Click to navigate to the previous record.

[k

Click to navigate to the next record.

b

Click to navigate the last record.

| M

Along with the basic actions, the following buttons are available for specific actions. The table
below gives a snapshot of them:

Basic Actions Description

Ij Show File - Click to view the details of selected file.

List Files - Click to generate and view the list of files maintained in
the system.

|__|ﬁr Download File - Click to download the details of selected data.

1.5.3 Personalization Options

You can personalize the data displayed in setup tables. Once personalized, system saves the
settings for that User ID until next personalization.

|'l!'iBWv Format « % Freeze HEDetach o] hirap E’al
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The table below gives a snapshot of them:

Options Description

View Click to personalize your view. The drop-down list provides the
following options of customization:

e Customize columns you wish to view
e Sort the order of displayed data
e Reorder columns

Additionally, the drop-down list provides selection of options
adjoining ‘View’.

M Format ~ | [&p Freeze pfiDetach

LI b showal
| Freez= + Product |
Detadh + Description ,
#ork » ¥ StartDt
Reorder Columns... + End Dt
Query By Example + Direct
+ Enabled

+ Collateral Type

+ Collateral Sub Type

+ Credit Bureau Portfolio Type
+ Credit Bureau Account Type

Manage Columns...

Format Click to resize columns or wrap a data in the table cells.
| e
Select the column you need to resize and select Resize Columns
option from the Format drop-down list.

Resize Column = I

Column DESCRIPTION

width | 100 ] [pixels [=]
OK. Cancel

Specify the Width and unit for the selected column. Click OK to
apply changes and Cancel to revert.

Query by Example | Click to query for the data by an example. When this option is
selected, the system displays an empty row above column heads.
You can specify all or any of the details of the record you wish to

query.
View » Format{ Freeze i Detach o1l Wrap o)
¢ | | @) %) i_
Freeze Select the column at which you need to freeze the table and click

Freeze. Function is similar to the freeze option in MS excel.

Detach Click to detach the setup table from the screen. An example of the
detached table is provided below.
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Options

Description

Wrap

Select the column in which the data needs to be wrapped and click
Wrap.

loan | Lne | Lease

Product Definition

Jpadd | JEdt | [Fven | o Audt

vew - [ | © | Mrrece gtococr | QM| @ vewrodct st copy
I I I I I Cotateratsub Ty |CredtBureat
prosuct et encoe |orect Fxive Repayment Enabled Jocdateraype  |cotatera subype [hedtBuens |
o+ LOANHOME (R)  p1/01/1800 12/31/4000 ¥ Y 2 HOME COLLATERAL - REAL PROPERTY HON INSTALLMENT
LOAN SECURED
Loans6 12/31/4000 N N v HOUSEHOLD GOODS PERSONAL PROPERT INSTALLMENT
WR)
Loanam oy SR b o1/1500 12/31/4000 v v ¥ UNSECLRED COLLATIUNSECLRED INSTALLMENT
Loanve LOANVEHICLE ()1 b1/01/1800 12731/42000 N v v VEHICLE COLLATERA PERSONAL PROPERT INSTALLMENT
MoP1 wopL 3/08/1863 12/31/4000 v N v VEHICLE COLLATERA PERSONAL PROPERT INSTALLMENT
MURABAHA B povse 031372013 v N v HOME COLLATERAL  REAL PROERTY HON INSTALLMENT
nDs1 NORM DSER 3/11/1853 1273174000 v N ¥ UNSECLRED COLLATIUNSECLRED ISTALLMENT
o1 et 1017201 12/31/4000 v N 2 HOME COLLATERAL REAL PROPERTY HOMMORTGAGE

Click to refresh the data in the table.

Print option in Customer Service screen

The Print button option in Customer Service/Collection screen facilitates you to print the
contents on the screen as is without scroll bars. This button is available along with other
options in the Action block. Clicking on this provides a browser print functionality and a new
tab is opened where the print content is displayed.

Detach

ORACLE'

Financial Services Lending and Leasing

&, Welcome, VAVAIDVA »  pccessibilty TSRO

N

Close
T Customer Service @
* Origination Search|| 2 quest (Pending: 0) .
Servicing
senicing Account(s): 20120200010231: YUTAKA OZAKA / AKANE [El view || <2 audt
Ctboics: Sl Viewv Formatw [5 Freeze 5 Detach o wrap W & @ curent O ShowAll C* Group Follow-up
Securtization Company Branch Sub Uit Account £ Product Days Past Due Currency Pay Off Ant Amount Due Status Oldest Due D
Transaction Authorization usot USRL UNDEFINED 2010200010231 LEASEVEHICLE 0.00 ACTIVE 10015
Post Date Checks
SOy Tadioe Summary | Customer Service | Account Details | Customer Details | Transaction History | PmtHodes || Bankruptcy | RepojForeclosure | Deficency | Collateral | Bureau | GrossUp el Activities
Account Documents
Collateral Management Call Activities  Maintenance Comments Promises ChecKists Tracking Attributes  References Corespondence Letters Document Tracking
Reports
Producers i i
Vendors Transaction Batch Information padd | At || Fview | & Auit
Batch Transactions View~ Formatv [ Freeze 5 Detach Wrap o 5 po % Voi
Advances Date Monet Transaction Status Batch
Payments 021072015 ADD CUSTONER ADDRESS PHONE POSTED "
Fees oot TERMIIATE ERROR N
Interfaces 01062016 TERMINATE voI N “
QusD0LS EXEvIO) von "
Detached Table x
View~| Format v [ Freeze [[EBetadh vap @ ot [5hvoid
Date Wonetary Transaction Status Batch
01of201s " ADD CUSTOMER ADDRESS PHONE POSTED "
03072016 ¥ TERMINATE ERROR N
01/05/2015 ¥ TERMINATE vo N
01/06/2016 Y EXTENSION Vo N
12472015 ¥ PAYOFF QUOTE LEASE POSTED [
Viewv Formatv [ Freeze Bl Detach @
> Collections Transaction Processing Details
swe ||| mE= Diret Record Update, Transaction Postng Successful “*+*%
> Tools
> Setup

Click ‘Add’, ‘Edit’ or ‘View’ button to open a new screen in expanded mode with details.

Drop-down List

The system provides an option to select the required data from LOV, for few fields. You can

either select the record from list or enter first alphabet of the value you want. When you
provide the alphabet, system limits the selection to the values starting with the specified
alphabet. These lists are grouped into two types:

o
list or enter first alphabet of the required value.

Drop-down list — Provides the selection option. You can either select a record from the
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e Combo drop-down list — The LOV contains huge data and prov

ides both selection and

search option. These drop-down arrows are smaller in size, when compared to normal

drop-down arrows, thus enabling easy identification.

ORACLE"
Financial Services Lending and Leasing

= Welcome, VAVAIDYA ~  Accessibility o

Casa Recondliation

Conversion Accounts 3 .
Transaction Batch Information

ustomer Service x Close.
> DashBoard Gt Ll
> Origination ~~ Seard gl C 8
Servicing
m—— Account(s): 20151200010012: MADHU BOBBURI B view || & auat
Customer Service Vieww Fomatv B3 [ Freeze i Detsch Wrap & ® curent O showall © Group Follov-up
Securitization Company Branch Sub Unit Account # Days Past Due Currency Pay Off Amt. Amount Due Status. 0ldest Due Dt
Transaction Autharization usot uskg 2015120001012 LOAN VEHICLE (FR) 21 usp 5031881 2,19:30 [T ET AT 01/01/2016.
Summary | Customer Service | Accourt De ory || Pt Modes| | Bonkiuptey | RepojForedos o =
;:EZ“E‘“”‘“”““”‘E“‘ Gall Adtvities | Maintenance | Comments || Promises | Cheekists || Tracking Attributes || References || Correspondence || Letters [ Zsaarch ]
Prod ) . ® Al O any
ven Transaction Batch Information Add |/ Edit ] vi £ Audit
Batch View v Fomatv [ Freeze EfiDetach ¢l wrap W post [ veid
Advances .
ot Date Vonetary Transaction accounTeL e
L o2f10f2016 ¥ Pt arch: Transacti
o= . 03/25/2016 n ACCOUNT SUB UNIT TRANSFER e
Interface: 0y/22/2016 n ACH HAINTENANCE pomdtily . Search e
AP Transactions 03/07/2016 r, 'ACH ONE TIME PHONE PAY e o DAY i @
GLTransactions 12/15/2015 v ADJUSTMENT TO ADVANCE / PRINCIPAL - ADD >

Parameters
View v Format +
> Collections
Parameter
> WP o data to display,
> Tools
> setup

Result

Reset | | AddFields || Reorder

Date 02/10/2016

* Monetary @) 0K || Cancel

&

Freeze i Detach

Value

Required

Click the arrow button available before ‘Search’ to toggle the search options.

Buttons/Menu Do this

Basic Click ‘Basic’ for normal search.

Advanced Click ‘Advanced’ for advanced search. In this mode, you can select
the search option from drop-down list adjoining the search criteria.
Selected record will be highlighted (Hover to select).

Match Select ‘All’ to display results exactly matching the specified
characters. Select ‘Any’ to display results matching any of the
specified characters.

Search Click to search for values based on the specified search criteria.
The search results are displayed below with the details in respective
columns.

Reset Click to reset the search criteria.

Add Fields Click to add additional fields to search criteria.

The search criteria are provided below the ‘Match’ field. These criteria vary based on the Field
for which the search is executed.

Also, the system remembers your recent search options and demarcates them from the actual

ones.
| * Channel | WEB ENTRY = * Producer Name [
NY-02: PR HOLTSVILLE 43125313212
MT-00001 : SGFSADDF RAMEY 23132132
LR} SR e 1
TIF-OUOO L T TEST-00T RTINS T 1
MN-00001 : TERMINATE AGUADA a
MT-00001 : SGFSADDF RAMEY 23132132
NY-02: PR HOLTSVILLE 43125313212
Search...
Comments

In all the user input screens wherever comments are accepted, the system allows an input of
4000 characters of information in the comment(s) field.
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1.6 Keyboard Compatibility

The system facilitates keyboard compatibility. You can perform most of your tasks using
keyboard short cuts also termed as ‘Hot Keys’. These hot keys are single keyboards or a
combination of keyboards. The available options are listed below:

1. Shift + Alt + mnemonic to activate buttons in the screen. For example, to open
‘Accessibility’ screen, press ‘Shift + Alt + y’.

2. Tab for forward navigation in the application. Shift + Tab for backward navigation in the
application. When the required link/tab/button/field is highlighted, press enter on the
keyboard to edit.

Space bar to check or uncheck ‘Check Box'.

4. Arrow Keys to hover within the drop-down list.

1.6.1 Keyboard Compatibility

The application is made compatible with keyboard only-operations. However, there is a
change in key combination based on the browser on which the application is running.

Browser Operating Key Combination Action
System

Google Chrome Linux Alt + mnemonic Click

Google Chrome Mac OS X Control + Option + mne- | Click
monic

Google Chrome Windows Alt +mnemonic Click

Mozilla Firefox Linux Alt + Shift + mnemonic Click

Mozilla Firefox Mac OS X Control + mnemonic Click

Mozilla Firefox Windows Alt + Shift + mnemonic Click

Microsoft Internet Windows Alt + mnemonic Set focus

Explorer 7

Microsoft Internet Windows Alt + mnemonic Click or set focus

Explorer 8

Apple Safari Windows Alt + mnemonic Click

Apple Safari Mac OS X Control + Option + mne- | Click
monic

Also, one can use the following keyboard shortcuts in order to increase or decrease the zoom

level.
Shortcut Action
Ctrl++ To increase zoom level.
Ctrl+- To decrease zoom level.
Ctrl+0 To set zoom level to default level.
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1.7

1.8

1.8.1

1.8.2

1.8.2.1

Tool Tips

The system is facilitated with tool tip option. When the cursor is moved to any of the field in
the screen, a popup is displayed with a tip on the action to be performed.

Accessibility

Application

Understanding Accessibility

Accessibility is making the application usable for multiple user groups, which includes users
with physical challenges. One of the most important reasons to make the application
accessible is to provide them the opportunity to work. The four main categories of disabilities
are visual, hearing, mobility and cognitive.

A person with disability might encounter one or more barriers that can be eliminated or
minimized by making the electronic information user-friendly and approachable.

Application Accessibility Preferences

Oracle Financial Services Lending and Leasing is facilitated with the feature of Accessibility
to make the application more usable for the people who are differently abled. You can set the
accessibility preferences after login. On the landing screen using 'Accessibility’ link on the
right end of the header set the following preferences as required

Screen Reader

Screen reader provides assistance to the visually impaired users. It interprets the screen
elements by reading them aloud.

High Contrast

High contrast feature increases contrast level to make the screen more appealing for the
reader with low vision.

Large Fonts

Large fonts feature increases font size to ensure clear display and appropriate spacing. This
benefits the reader with low vision.

For Visual Challenges

The visual challenges varies widely, however it generally includes, blindness, low vision or
color blindness. To make the application more accessible, following features are provided.

Blindness:

In order to interpret the visual display information in the audible form, Screen reader
compatibility is provided.
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1.8.2.2

1.8.2.3

1.8.3
1.8.3.1

In places where Screen reader technology cannot obtain information from images, text
equivalents for images are provided.

For Users with difficulty in using mouse, since it requires hand and eye coordination,
Keyboard navigation is provided. Details of keyboard navigation is provided in ‘Section 1.8.3.2
Keyboard Compatibility’.

Low vision:

For Users who cannot view the content that has small font size and cannot be enlarged,
Software magnifier is provided to enlarge text and images beyond normal font enlargement.

Also, there is no information presented using attributes such as depth, size, location, font etc.

For high contrast requirements Screen setting can be adjusted.

Color blindness:

Oracle Accessibility guidelines have been followed and hence accessibility issues relating to
color blindness are addressed.

Also, high contrast colors have been used to address difficulty in identifying shades of colors.
For example, Black text in white background.

For Hearing Challenges

People with hearing challenges or hard of hearing might encounter problems accessing the
information presented using sounds. Some application features minimize their concerns.

Visual representations of audible information is provided so that Users with this challenge do
not miss information presented using audio.

For Age-related Challenges

Apart from the above, there can be aging issues like week eye-sight or hearing.

Issues related to week eyesight can be addressed through Application features for Visual
Challenges provided in ‘Section 1.8.2.1 For Visual Challenges’.

Issues related to hearing can be addressed through Application features for hearing
challenges provided in ‘Section 1.8.2.2 For Hearing Challenges’.

For Users who are less familiar with computers, the simplified user interface with easy
navigation options, uniform layout and design and commonly used terminology in the
application is of great advantage.

To address issues relating to understanding complex information, User manuals are provided
for online help and tool tips at all required places are provided. In addition, system messages
like error, warning or information helps you through.

Other Accessibility Considerations

Documentation Accessibility

Apart from assigning the logical sequence and organizing topics, the following techniques are
used to enhance the accessibility of documentation.

e Addition of text equivalent to all graphics
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1.8.4

e Usage of standard fonts and avoiding shadow or reversed text

e Usage of strong foreground and background color contrast

e Color usages as per Oracle Accessibility guidelines have been ensured
e Usage of styles and formatting elements

e Documentation in simple language to ensure easy understanding

e Including accurate and effective navigational features, such as cross-reference, tables
of content and bookmarks as appropriate

Setting up Accessibility Preferences

You can setup or change the accessibility preferences.

To edit accessibility settings

1. Click Accessibility in the header part of application. The system displays the following
screen:

Oracle Financial Services Lending and Leasing L]
Accessibility Preferences

Edit Accessibility Settings

Any setting made is saved untl changed here again.’ : "Any setting must be
made for each browser session.

Screen reader
High contrast
Large fonts

Submit Cance|

2. Select any or all of the required options to edit or change the accessibility settings.

3. Click Submit.

Note

You need to define the required Settings for each browser session and defined settings
are saved until next modification.
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2.1

2. Wholesale Floor Planning Setup

This chapter explains how to use the Wholesale Floor Planning Setup window to set up the
WFP module in Oracle Financial Services Lending and Leasing.

Note

Although WFP is a separate module, it uses the Oracle Financial Services Lending and
Leasing system’s seed data, as well as lookup codes defined on the Setup menu’s Admin-
istration form. The Wholesale Floor Planning Setup form only records setup data specific
to the WFP module (just as the Setup menu’s Product module records data specific to the
Loan, Line of Credit, and Lease modules.)

Please do not set up the Wholesale Floor Planning module until after you have completed all
other aspects of Oracle Financial Services Lending and Leasing setup.

Set up the WFP Lookups

Note

For more information about lookups, see this section of the Lookups link (Lookups Set-
up Screen) in the Administration System Setup of this guide.

To set up the WFP lookups

1.

On the Oracle Financial Services Lending and Leasing -home screen, click the Setup
master tab.

Click the Administration bar link.

In the Administration screen’s link bar, click the System drop-down link, then click
Lookups.

In the Lookups Setup screen’s Lookup Types section, the following lookup codes apply
to the WFP module:
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211

Set up the WFP Parameters

Lookup Type:

Description:

WFP_ACCR_BASE_DAYS_CD

BASE DAYS FOR COMPUTING ACCRUALS IN
WEP

WFP_ADJUSTMENT REASONS CD

BATCH FILE ADJUSTMENT REASONS

WFP_ADJUSTMENT TYPES CD

BATCH UNITS FILE ADJUSTMENT TYPES

WFP_BATCH_STATUS TYPES CD

BATCH UNITS FILE STATUS TYPES

WFP_CL_ALTER_ACTIONS_CD

ALTERATION ACTION ON CREDIT LINES IN
WEFP

WFP_CL_ALTER_REASONS_CD

CREDIT LINE CHANGE REASONS

WFP_CONDITION REASONS CD

UNIT CONDITION REASONS

WFP_DELAY DAY BASIS_CD

DELAY DAY BASIS

WFP_FEE_CALC_METHODS_CD

FEE CALCULATION METHODS

WFP_GL HEADER SEGMENTS

GL HEADER SEGMENTS (SUB CODE USED
FOR LABELS IN GLIS03)

WFP_LEVEL_IND_CD

SUB-TRANSACTION LEVEL INDICATORS

WFP_MONETARY REASONS_CD

MONETARY TRANSACTION REASONS

WFP_PMT_MODES_CD

PAYMENT MODES OR METHODS

WFP_PMT REASONS CD PAYMENT REASONS
WFP_PMT_STATUS TYPES CD PAYMENT STATUS TYPES
WFP_PMT TYPES CD PAYMENT TYPES

WFP_PRODUCER_STATUS -
TYPES_CD

WHOLESALE PRODUCER STATUS

WFP_RATE_REASONS_CD

RATE CHANGE REASONS

WFP_RESCHED REASONS CD

UNIT RE-SCHEDULING REASONS

WFP_TXN_ACTION_TYPES_CD

TRANSACTION ACTION TYPES FOR FLOOR
PLANNING

WFP_TXN_BALANCE_TYPE_CD

WHOLESALE FLOOR PLAN WFP WBT BAL-
ANCE CD CODES

WFP_TXN_SUB_TYPES_CD

TRANSACTION SUB TYPES (SUB CODE USED
FOR INDICATING BALANCE)

WFP_TXN_TYPES_CD

FLOOR PLANNING TRANSACTION TYPES

WFP_UNIT_ASSET TYPE_CD

WHOLESALE FLOOR PLAN ASSET TYPES

WFP_UNIT_COND_ACTION_CD

ACTION ASSOCITED WITH THE WFP UNIT
CONDITION
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Lookup Type: Description:

WFP_UNIT COND REASONS CD UNIT CONDITION REASONS

WFP_UNIT COND _TYPES CD UNIT CONDITION TYPES

WFP_UNIT_STATUS_REASONS_CD | UNIT STATUS CHANGE REASON

WFP_UNIT STATUS TYPES CD UNIT STATUS TYPES

WFP_UNIT TYPES CD FLOOR PLAN UNIT TYPES

WFP_WCP_CEIL INDEX CD WHOLESALE FLOOR PLAN WFP WCP CEIL
INDEX CD CODES

WFP_WCP_MARGIN INDEX CD WHOLESALE FLOOR PLAN WFP WCP MAR-
GIN INDEX CD CODES

WFP_WCP_UNIT CD WHOLESALE FLOOR PLAN WFP WCP UNIT
CD CODES

WFP_WFR_FEE CALC - WHOLESALE FLOOR PLAN WFP WFR FEE

METHOD CD CALC METHOD CD CODES

WFP_WIB LEVEL IND CD WHOLESALE FLOOR PLAN WIB LEVEL INDI-
CATOR CODES

The following parameters apply to the WFP module:

e WFP MAX_CYCLES BACKDT
e WFP _REVERSE TXN_IND

Wholesale Floor Planning parameters are set up at the system level.

System level parameters
In setting up system level parameters for wholesale floor planning, you will need to know the
answer to the following two questions:

e The number of cycles back dated
e Which transactions use the reverse indicator?

Note

For more information about system level parameters, see this section of Parameters link
(Parameters Setup screen) in the Administration System Setup of this guide.

To set up the WFP parameters at the system level

1. On the Oracle Financial Services Lending and Leasing home screen, click the Setup
master tab.

2. Click the Administration bar link.

3. Inthe Administration Setup link bar, click the System drop-down link, then click
Parameters.

4. Click the Parameters drop-down link, then click System.

5. Onthe System Parameters Setup screen’s System Parameters section, search for and
set up the following parameters:
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Parameter:
WFP_MAX CYCLES BACKDT

Description:

WFP TRANSACTION NO.OF CYCLES BACKED

Parameter Value:

Type the number of cycles backed.
Parameter:
WEFP_REVERSE_TXN_IND
Description:

WFP REVRESAL OF TXN INDICATOR
Parameter Value:

Type the number of cycles backed.
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3.1

3.2

3. Index Rates

Introduction

The Index Rates maintains your organization’s history of periodic changes in index rates as it
applies to wholesale floor planning. It allows you to define the interest rate for the loans
extended to the producers by type of credit line. The index rate provides the base rate for a
credit line where:

interest rate = index rate + margin rate.
An index type can have different rates depending on the start date. For each index type, the

Index Rates section records the interest rate and the start date after which the rate is
applicable. If you do not want to use a variable index rate, you can use the flat rate index.

Index Rate Link

While you can add new rates for an existing index type, you cannot modify or delete existing
index rates.

To use the Index Rates link

On the Oracle Financial Services Lending and Leasing home screen, click Setup— Setup
—>WFP—>Index Rates

1. Inthe Index Types section, select the record you want to work with. Note: PRIME RATE
» Origination T Ty o g o
Viewv Fomatv Freeze i Detach rap ®

> Collections IndexType Short Description _ Deseription i

pMER PRIME RATE PRIME RATE PRIME RATE ‘j

» Servicing

» Tools
Setup
Index Types

[ save and add || [ save andstay | [ save and Return | 2 Retum

Index Type v * Enabled @
short Description

* Description

4 Index Rates o add | Z Edt View | o Audit
ieviv Format v [} Freeze i Detach rap W

Start Ot Rate Enabled
Ho data to display.

and FLAT RATE are the default, system defined rate types.

Note

If you choose, use Search Criteria to limit the display of records.
— If you are entering a new record, click Add.
— If you are changing an existing record, click Edit.
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2. Inthe Index Types section, enter, view, or edit the following information

In this field: | Do this:

Index Type Select the index type (required).

Short Enter the short description of the index rate type (required).
Description

Description | Enter the longer description of the index rate type
(required).

Enabled Select to enable the index rate type.

3. Inthe Index Rates section, select the record you want to work with.

Note

If you choose, use Search Criteria to limit the display of index rates records.
If you are entering a new record, click Add.

4. In the Index Rates section, enter the following information

In this field: | Do this:

Start Date Enter the start date of the index rate. Note: This cannot be less than
current date (required).

Rates Enter the rate. Note: For a particular index type, multiple rates cannot
be entered in the Index Rates section with the same start date
(required).

Enabled Select to enable the index rate.

5. Click Save in the Index Types section.
For example,

Using the data in the sample graphic, let’'s assume the current date is February 5, 2009 (10/
30/2008).

The entries in the Index Rates section for a PRIME RATE include:

Start Date Rate

01/29/2009 3.0

10/16/2008 12.0

10/03/2008 8.0

In this scenario 8.0% will be the rate used by Oracle Financial Services Lending and Leasing
to compute interest on October 10, 2008.
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4. Fees

4.1 Introduction

The Fees link allows you to define the method of computing the various producer, credit line,
and unit level fees. You can define different fee calculations for a state, producer, and credit

line.

Note

The Fee Rules section on the Fees link displays all the system defined balance types,
even those disabled on the Balance Types screen. This is necessary for Oracle Financial
Services Lending and Leasing to retain the fee rules associated with the balance type in
case any are already associated with any existing units.

4.2 Fees Link

To use the Fees link

On the Oracle Financial Services Lending and Leasing home screen, click Setup— Setup

ORACLE 3 Welcome, VAVAIDYA = pccessity &
Financial Services Lending and Leasing
ees x close
> DashBoard L =
ination
Fee Balance Types (Bl iew
0 2 Viewv Formatw [
> Collections = =
> WP AN PRODUCER
Aup CREDIT LINE
> Tools wr unr
Lc LATE CHarcE unar
nsF ON SUFFICIENT FuNiDS PRODUCER
om FeEs unr
P5 Latic unr
sve UNIT SERVICE FEES unar
Fee Rules Fradd | Zeat | Hview | o vt
[Ty — R T jows w | @
state Producer = : Niame CreditLine start Dt Enabled cale
02/11/2016 12/31/4000 ¥
ARMED FORCES AMERICANS (EXCEPT CANADA) ALL 1:1 03/05/2016 12/31/4000 ¥ [y
ALASKA AL 1:1 oy/03/2016 12/31/4000 v PERI
AL AL AL 1201572015 v P
4 A AL AL 12/142015 v FLC
AL AL AL 1201972015 v P
AL AL AL 1271572015 v P
AL AL DE0 : DEMO VEHICLES 12/142015 12/14/2015 I PERI
AL AL AL 1202372015 12/31/4000 ¥ unr
u AL AL 1203072015 12/31/4000 v PRI~
»
Fee Rules
e ana A (i Save o st [ Seve and Rt [ Ga Bctin
“state v Eendot 12/31/4000 B “Fee
Producer # : 1 ® * Enabled @ “Fee
it ine k2
* start ot 02/11/2016 | B
“About

‘Copytight © 1998,2016, Oracle andjor ts afflates. All nghts reserved,

1. Inthe Fee Balances Types section, select the record you want to work with.

Note
If you choose, use Search Criteria to limit the display of instrument records.

2. Inthe Fee Balances Types section, view the following information:

In this field: View this:

Fee The system defined fee types applicable for WFP (display only).

Description The balance description of the fee type (display only).
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In this field: View this:

Level View the balance type level at which a fee is applicable: PRODUCER,
CREDITLINE, or UNIT (display only).

3. Inthe Fee Rules section, select the record you want to work and click Show in the Details
column.

Note

If you choose, use Search Criteria to limit the display of the fee rule records.
— If you are entering a new record, click Add.
— If you are changing an existing record, click Edit.

4. Inthe Fee Rules section, enter, view, or edit the following information:

In this field: Do this:

State Select state initials (required).

Producer #: Name | Select the producer (optional).

Credit Line Select the credit line (optional).
Start Date Start the date from when the fee rule is applicable (required).
End Date Start the date till which the fee rule is applicable.

A blank field indicates no end date (optional).

Enabled Select to enable this fee rule.
Calculation Select the calculation method. If the calculation method is FLAT,
Method then Fee% field should have the value 0.0 and the Fee Amount -

Maximum field would have the same value as that in the Fee
Amount - Minimum field. Oracle Financial Services Lending and
Leasing uses the Fee Amount - Minimum field for fee calculation
(required).

Fee% Enter the fee percentage (required).

Fee Amount Mini- | Enter the minimum fee amount that would be charged to the pro-
mum ducer (required).

Fee Amount Maxi- | Enter the maximum fee amount that would be charged to the pro-
mum ducer (required).

5. Click Save on the Fee Balance Types section.

FLEXCUBE WFP supports the following types of fees and calculation methods:

Description Level Calculation Methods supported
NON SUFFICIENT PRODUCER FLAT

FEES

PRODUCER PRODUCER FLAT

ANNUAL FEES
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Description Level Calculation Methods supported

CREDIT LINE AUDIT | CREDIT LINE FLAT

FEES

LATE CHARGE UNIT FLAT
PERCENTAGE OF PAYMENT DUE
PERCENTAGE OF BALANCE PAYMENT
UNIT CHARGE

UNIT SERVICE FEES | UNIT FLAT

UNIT OTHER FEES UNIT FLAT

4-3
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5.1

5.2

5. Pricings

Introduction

The Pricing link records the various pricing plans the financial institution offers to its
producers. By default, sample pricing plans are available while setting up WFP. You can then
modify and add plans to this screen. At least one pricing plan should be enabled.

Pricing Link

Oracle Financial Services Lending and Leasing takes the index rate from the Index Rates
screen for the code in the Margin Index field and adds the value of the Margin Rate to
calculate the credit line’s interest rate.

You cannot define different pricing policies for different producers (since producer is not a part
of Policies setup). However, it is possible to overcome this by having two different credit lines
on the Pricing screen, NEW-PRODUCER A and NEW-PRODUCER B, with the same unit type
NEW.

To use the Pricing link

On the Oracle Financial Services Lending and Leasing home screen, click Setup— Setup
—>WFP—>Pricings

ORACLE 3, Welcome, VAVAIOVA = accessity =)
Financial Services Lending and Leasing

Close
> DashBoard fricksr -

Pricing Details Fadd | Lo | [Elvien || L auie
View Format v

unit Indax Start Ot Endot Ensblad Initial Adv % Term
> WEP

DEMONSTRATOR VEHICLES PRIME RATE
DEMONSTRATOR VEHICLES PRIME RATE
DEMONSTRATOR VEHICLES PRIME RATE
w PRIME RATE
PRIME RATE
PRIME RATE
PRIME RATE
LOANER VEHICLES PRIME RATE
DEMONSTRATOR VEHICLES PRIME RATE
PRODUCER TRADES PRIME RATE
USED VEHICLES
USED VEHICLES PRIME RATE
USED VEHICLES PRIME RATE
DEMONSTRATOR VEHICLES PRIME RATE 1242212015

12/31/4000 v 100.0000 2
12/33/4000 v 100.0000 2
12/31/4000 ¥ 100.0000 2
12/31/4000 v 100.0000 2
12/31/4000 v 100.0000 7
12/33/4000 v 100.0000 o
12/31/4000 ¥ 100.0000 7
12/31/4000 ¥ 100.0000 2
12/31/4000 v 75.0000 2
12/33/4000 v 100.0000 2
12/31/4000 ¥ 300000 12
12/31/4000 ¥ 700000 4
12/31/4000 v 700000 4

TRaDE TRADE

Pricing Details

8

start it

Note

In the Pricing Details section, select the record you want to work with and click Show in
the Details column.

If you choose, use Search Criteria to limit the display of records.
— If you are entering a new record, click Add.
— If you are changing an existing record, click Edit.

1. In the Pricing Details section, enter, view, or edit the following information:

In this field: | Do this:

Code Enter the pricing code (required).

Credit Line Enter the credit line. Each entry in the list should be unique (required).
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In this field: | Do this:

Description | Enter a description of the credit line (required).

Unit Select the unit type. This describes the type of unit to which the pricing
applies (required).

Start Date Enter the start date. This is the date after which the pricing plan would
be in use and available in maintenance. Note: The start date of a pricing
plan cannot be less than the current date (required).

End Date Enter the end date. This is the date after which the pricing plan would
not be available. Note: The end date cannot be less than the current
date or start date (optional).

Enabled Select to enable the pricing policy.

Initial Adv% | Enter the initial advance percent. This indicates what percent of the
value of the unit is given to the producer as an advance (loan). For
example, if the value of a new vehicle is $10,000 and the loan given to
the producer is $8,000 then the initial advance percent is 80 percent
(optional).

Term Enter the total term in months. This indicates the maximum term (in
months) of the credit line (optional).

Current Yr Enter the percent of outstanding principal which need tobe recovered
Curtailment | from the producer each month in the current year.

Prior Year Enter the prior year curtailment percent (optional).
Curtailment

Margin Rate | Enter the margin rate. The interest rate equals the index rate plus mar-
gin rate. Index rate is the applicable interest rate for the selected index
type (optional).

Ceiling Select the ceiling index code. This indicates the index on which the
Index interest rate ceiling would be based (optional).

Ceiling Rate | Enter the ceiling margin rate. This defines the ceiling for interest. The
ceiling rate equals the ceiling index rate plus the ceiling margin rate. For
example, if the index rate is three percent, the margin rate is one and a
half percent, and the ceiling rate is five percent, then the interest rate is
four and a half percent. If the index rate increases to four percent, the
interest rate will be five percent and not five and a half percent
(optional).

2. Click Save in the Pricing Details section.
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6. Contracts

6.1 Introduction

The Contract link allows you to define the terms and conditions of your contracts. Contracts
can be defined according to company, branch, and type of unit. You can add new contracts
and modify the existing ones.

6.2 Contracts Link

Oracle Financial Services Lending and Leasing selects which instrument to offer based on
whether:

e The instrument company/ branch matches the producer company/ branch. Note: We
recommend setting up an instrument where the company / branch is ALL/ ALL to ensure
proper performance in Oracle Financial Services Lending and Leasing

e The contract date at unit level should be between the instrument start and end date
e The instrument is enabled.

To use the Contract link

On the Oracle Financial Services Lending and Leasing home screen, click Setup— Setup
—>WFP—> Contracts

opacLe

Financial Services Lending and Leasing

ontracts. (3] Close
> DashBoard il L
> Origination Iy P
2 Instrument dau | e | Even | Lot
> Servicin
9 View~ Formatv [ Frecze G Detach Wrap (5]
> Collections W
Name Description Company Branch Start Dt End Dt Enabled Unit Start Basis CATER I ‘;\/"rltteuﬂTn\E\ante Pmt Tolerance %
> WFP i
ozf1ij2016 v 3 o0 000 0.0000
> Tools FPL3 TEST2 Loz NLHQ 12/15/1993 12/31/4000 i E 0.00 0.00 0.0000
e TESTS TESTS 1804 IrHq /1772015 N £ 000 000 0.0000
FIWEP_INST 5 usn1 ushg 22189 12/22/99%9 Y £ 1000 000 100000
Setup TEST NEW VEHICLE TS uso1 uskg 11172000 2/11/4000 ¥ £ 1000 1000 10000
FPL1 Floor Plan Instrument 1 US01 USHQ 12/07/1993 12/31/4000 Y E 10.00 10.00 3.0000
FPL2 Floor Plan Instrument 1 US01 USHQ 12/07/1993 12/31/4000 Y E 5.00 20.00 3.0000
TESTL TSI 304 HQ 1142015 N e 000 000 0.0000
»
IndexRates
Feie Instrument
Pricings B save and add saveandstay | [ saveandRetum || Ca Retum
Contracts i
Balances * Name * Start Basis EFFECTIVE DATE i * Accrual Base Days 365
Transactions “ Desription “ Acerual start Days 0
Spreads
* Company
*Branch
“start ot 0212016 B
End Dt &
* Enabled & se |
“Unit v * Max Rate Decrease / Year 00000 * Max Rate Decrease / Life 00000
Fadd | /it LA
Instrument Balance Types add | /et | [E]view Audit
View~ Formatv [ Frecze ] Detach Wrap ]
- Include Monthly
Balance Type Level B
Mo data to display.

Note

In the Instrument section, select the record you want to work with and click Show in the
Details column.

If you choose, use Search Criteria to limit the display of records.
— If you are entering a new record, click Add.
— If you are changing an existing record, click Edit.
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1. In the Instrument section, enter, view, or edit the following information:

In this field: | Do this:

Name Enter the unique name of the instrument (required).

Description | Enter the instrument description. This entry should briefly describe the
instrument (required).

Company Select the company for which the instrument is applicable (required).

Branch Select the branch of the company for which the instrument is applicable
(optional).

Start Date Enter the start date. This is the date after which the instrument is in use
and is available on the Wholesale Floor Planning Maintenance form
(required).

End Date Enter the end date after which the instrument is invalid and unavailable
on the Wholesale Floor Planning Maintenance form. While this field
can be empty, it cannot be less than the current date or start date
(required).

A blank field indicates no end date (optional).

Enabled Select to enable the contract instrument.

Unit Select the unit type (required).

This field links the policies to contracts. There should be at least one
enabled contract for every unique unit type (required).

Start Basis Select the accrual start date basis. This indicates the date from which
the interest rate would be calculated. For example, a start basis that
equals the payment date implies that the interest rate calculation starts
with the first payment date (required).

Payment Enter the payment tolerance amount. This defines the acceptable

Tolerance shortfall in the monthly payment in dollars for which no penalty would

Amount be imposed (required).

Writeoff Tol- | Enter the writeoff tolerance amount. This is the tolerance acceptable

erance while a unit gets paid off. The unit will be considered paid even if pay-

Amount ment is falling short of actual due by this amount (required).

Pmt Toler- Enter the payment tolerance percent. This defines the acceptable per-

ance% cent of the monthly payment due which no penalty would be imposed.
For example, the tolerance can be set for 95 percent of payment due
(required).

Late Charge | Enter the late charge grace days. This is the number of days after the

Grace days | payment due date during which no late fee would be charged
(required).

# Rate Enter the number of rate changes in a year. This is the maximum num-

Changes/ ber of times the rate can be changed in a year for a unit. Note: The

Year number of rate changes in a year cannot exceed the number of rate

changes for the life of the contact (required).
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In this field:

Do this:

Max Rate Enter the maximum rate increase in a year. This is the ceiling limit for

Increase rate increases in a year (required).

Year

Max Rate Enter the maximum rate decrease in a year. This is the floor limit for

Decrease rate decreases in a year (required).

Year

Accrual Select the accrual base days. This is the number of days the instru-

Base Days ment assumes in a year for interest computation: 360, 365, or 366. If
the accrual base is selected as 365, the interest computation would be
based on actual days (365) and the base would be 365. However, in
this case, if the year happens to be a leap year and the actual day’s
computation includes the month of February, then the additional day of
leap year is not considered (required).

Accrual Enter the accrual start days. This is the number of days after which

Start Days interest accrual starts once the instrument is in use (required).

Refund Tol- | Enter the refund tolerance amount. If the refund due to the producer is

erance more than this, the tolerance amount is refunded. Note: You cannot

Amount complete this field if the Refund Allowed box is selected (required).

DIq Grace Enter the delinquency grace days. This is the number of days after the

Days payment due date during which the account will not be considered
delinquent (required).

# Rate Enter the number or rate changes in life. This is the maximum number

Change Life | of times the rate can be changed during the life of the contract
(required).

Max Rate Enter the maximum rate increase in life of loan. This is the ceiling limit

Increase for rate increase during the entire life of the contract (required).

Life

Max Rate Enter the maximum rate decrease in life. This is the floor limit for rate

Decrease decrease during the entire life of the contract (required).

Life

Refund If selected, this check box indicates this instrument allows a refund in

Allowed case the producer pays in excess of what is due (required).

The Instrument Balance Types section allows you to define the balance type for the selected

instrument at the producer, credit line, or unit level.

2.

In the Instrument Balance Types section, select the record you want to work with.

Note

If you choose, use Search Criteria to limit the display of records.

— If you are entering a new record, click Add.

— If you are changing an existing record, click Edit.
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3. Inthe Instrument Balance Types section, enter, view, or edit the following information:

In this field: Do this:

Select If selected, indicates that this is the current record.

Balance Type Select the balance type (required).

Level View the level indicator. This entry is based on the selected
Balance Type and is non-editable (required).

Include Monthly Due ? | Select to compute the minimum monthly payment.

4. Click Save in the Instrument section.
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7.1

7.2

7. Balances

Introduction

The Balance Types link displays the various types of balance types computed for each
producer (or “dealer”) set up in the WFP module. The balances defined in the Balance Types
section are fixed, system defined, and set up during WFP installation. You cannot add or
modify any balance types. However, you can choose not to use a balance type by clearing its
Enabled check box.

Balances Link

To view the Balance Types link

On the Oracle Financial Services Lending and Leasing home screen, click
Setup— Setup—WFP—Balances

Note

If you choose, use Search Criteria to limit the display of records.

2. In the Balance Types section, view the following display only information:

In this field: | View this:

Type The transaction type.

Code The balance code.

Description | The description.

Level The balance level. This indicates whether the balance is computed at
PRODUCER, CREDIT LINE, or UNIT level.

Enabled Select to enable the balance types. When this check box is clear, Oracle
Financial Services Lending and Leasing will not compute this balance
from that date on for all new producers, credit lines, or units.
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Note

The balance types PRINCIPAL BALANCE and INTEREST should be enabled at the UNIT
level.
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8.1

8.2

8. Transactions

Introduction

The Transactions records the system defined, consolidated list of transaction codes available
in the WFP module.

The transaction codes defined on this screen are fixed, system defined, and set up during
WEFP installation; you cannot modify them. However, you can choose not to use a transaction
code by clearing its Enabled check box. You can also choose which transactions affect the
general ledger by selecting the GL check box.

The transaction codes defined here are available on the Wholesale Floor Planning
Maintenance form.

Note

If any transaction code is disabled on the Transaction Codes screen, it may have an im-

pact on the spreads if the disabled transaction code was listed in the Spread Details sec-
tion on the Spreads screen. Oracle Financial Services Lending and Leasing would not be
able to prevent allocation of payment to this code in spite of it being disabled.

Transaction Codes Link

To use the Transaction Codes link

On the Oracle Financial Services Lending and Leasing home screen, click Setup— Setup
—>WFP— Transactions

ORACLE = Welcome, VAVAIDYA »  Accessibility o
Financial Services Lending and Leasing

> DashBoard Transactions x

» Origination "
g Transaction Codes /i || Eview | 2 puat

> Servidng Views Fomat B | [[|Fecze | vetach w | @

> Collections Code escr Trpe Sub Type Action
> WEp PITDUE UE DATE DUEDATEHISTORYFORUNTTS  DUEDDATE poST

DsER T DISELRSED
> Tools FAANL E FEE PPRODUCER ANNU!
FEANL AL FEE - BLLED FEE
OFAAIL ANNUAL FEE - CHARGE-OFF FEE
QFAANL CHARGE-OFF FEE
REABNL ree
RFBANL
VEABNL
WFAANL

FEE
FeE
FEE

Transaction Codes

Code PITOUE SubType DUE DATE o
* Description PMT DUE DATE Action POST Enabled @
Type DUE DATE HISTORY FOR UNITS * bl

Transaction User Access Definition add | At | [ ve  Audit
Vieww Formatv [ Freeze [ Detach Wrap o
Access Value Allowed? Yes/No
Yes Mo

Access Type
RESPONSIBLLITY AL

1. Inthe Transaction Codes section, select the record you want to work with.

Note

If you choose, use Search Criteria to limit the display of records.
— If you are entering a new record, click Add.
— If you are changing an existing record, click Edit.
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2. Inthe Transaction Codes section, enter, view, or edit the following information

In this field: | Do this:

Code Enter transaction type code. This is a system defined code for the
transactions. The first letter of the code indicates the type of task the
transaction performs:

P — payment

F —fee

O - charge off

Q - reverse charge off
R —reverse

W — waive

V — reversal of waived transaction (required).

Description | Enter the description associated with the Transaction code. This is a
system defined field that can be modified by users (required).

Type Select the transaction type. This field maps the transaction code to
into Transaction types (required).

Sub Type Select the sub type (required).

Action Select the action type. For more information about the Action field, see
the following section,

A Note about the Action Field. Note: If a transaction code has an
action of POST, WAIVE, or CHARGEOFF, then a REVERSE action
should also be associated with this code (required).

Manual Select to allow users to post these transactions on the Wholesale
Floor Planning Maintenance form.

GL Select to post the transaction to the general ledger when performed.

Enabled Select to enable the transaction code.

Note: Transactions codes which are not selected are not available in
the LOVs on the WFP maintenance screens.

Note

Transaction codes of transaction type INTEREST and PRINCIPAL cannot have a cleared
Enabled check box.

3. Click Save in the Transaction Codes section.

A Note about the Action Field

The Action field indicates how the transaction code affects the account. The standard actions
associated with the various transaction codes are as follows:

e POST
e BILLING
e CHARGE-OFF
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e WAIVED
e REVERSE
e VOID

Most Type field and Sub Type field combinations have an action and a reverse action
associated with them. Each Type field, Sub Type field, and Action field combination is
identified using a unique transaction code.

For example,

The Type FEE and Sub Type PRODUCER ANNUAL FEES combination has the eight following

actions associated with it, each having a unique transaction code:

Note that there are four actions and four reverse actions associated with the Annual Fee.

Fee Waived

Code Description Type Sub Type
FAANL Annual Fee Fee Producer
Annual Fees
RFAANL Reversed - Annual Fee Producer
Fee Annual Fees
FBANL Annual Fee - Billing | Fee Producer
Annual Fees
RFBANL Reversed - Annual Fee Producer
Fee Billing Annual Fees
OFAANL Annual Fee - Char- | Fee | Producer Chargeoff
geoff Annual Fees
QFAANL Reversed - Annual | Fee Producer
Fee Chargeoff Annual Fees
WFAANL Annual Fee - Fee Producer
Waived Annual Fees
VFAANL Reversed - Annual Fee Producer

Annual Fees

Most of the Type and Sub Type combinations would have these eight transaction codes.
However, there are some transactions such as Payment, Rate Change, Rescheduling Unit,

Void, and Status Change which may not have all eight codes.

Details of the transaction codes would be listed in the seed data.
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9.2

9. Spreads

Introduction

The Spreads link records the order in which Oracle Financial Services Lending and Leasing
allocates a payment spread for a spread transaction code. You can add to or disable the seed
data sample spreads on this screen as you choose. However, you must verify that there is no
residual dollar amount, as Oracle Financial Services Lending and Leasing refunds the
producer any balance not used in the spread.

Spreads Link

Spread details uses the transaction codes listed in the transaction codes setup. In case any
of the transaction codes are disabled from transaction codes setup, Oracle Financial Services
Lending and Leasing would not remove that code from spread details. You must manually
verify that such codes are removed from the spread details as well.

To use the Spreads link

On the Oracle Financial Services Lending and Leasing home screen, click Setup— Setup
—>WFP—> Spreads.

ORACLE’
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UNIT

READ - FEE ONLY UNIT
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e

N
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¥

Y

[

[
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E
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Y
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1. Inthe Spread Codes section, select the record you want to work with.

Note

If you choose, use Search Criteria to limit the display of spread code records.
— If you are entering a new record, click Add.
— If you are changing an existing record, click Edit.

2. Inthe Spread Codes section, enter, view, or edit the following information:

In this field: | Do this:

Code Enter an unique code for the spread (required).
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In this field: | Do this:

Description | Enter a description for the spread code (required).

Level Select the indicator to define the level at which the fee is applicable.

Note: While making changes on the Spreads screen, make sure that
there is one and only one enabled spread code for each level

(required).
Default Select to indicate this a default spread code.
Enabled Select to enable this spread code.

The Spread Details section records the details of the transaction codes to which Oracle
Financial Services Lending and Leasing applies the spread, as well as the priority for applying
the spread over multiple transactions. At least one enabled transaction code should be
available for each spread.

3. Inthe Spread Details section, select the record you want to work with.

Note

If you choose, use Search Criteria to limit the display of spread details records.
— If you are entering a new record, click Add.
— If you are changing an existing record, click Edit.

4. In the Spread Details section, enter, view, or edit the following information:

In this field: | Do this:

Txn Code Select the transaction code (required).

Description | View the transaction code description as set up on the Setup master
tab’s Transaction Code screen (display only).

Seq Enter the sequence in which the spread would be applied to various
Txn codes (required).

Enabled Select to enable the this spread detail.

5. Click Save on the Spread Codes section.
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Appendix A: Late Fee Methods Definitions

FLAT AMOUNT

FLAT AMOUNT charges a flat (fixed amount) fee when an account becomes overdue.

For example, if the FLAT AMOUNT late fee is set at $25, and the account is $900 overdue,
then the late fee assessed will be $25. For each month the account is overdue, regardless of
the amount, the late fee assessed will be $25.

PERCENTAGE OF PAYMENT DUE

PERCENT OF PAYMENT DUE charges a late fee based on a percentage of the part of a
payment due that remains to be paid.

For example, if the PERCENT OF PAYMENT DUE late fee is set as 10%, and if only $90 of a
$200 standard payment is due, then the late fee will be $9 (10% of 90).

If $3000 on a loan with a standard payment of $200 is due, the late fee will be $20 (10% of
200). This is because the computed late fee is based only on the payment due for that month
-- not the accumulated due amount.

If the stated monthly payment is $300 and account is delinquent for 3 months ($900), then
every month the late fee is computed only on the amount due for that month ($300 or part of
$300) -- not on $900.

PERCENTAGE OF STANDARD PAYMENT

PERCENTAGE OF STANDARD PAYMENT charges a late fee based on the standard monthly
payment, regardless of the current amount due.

For example, if you set 10% as the PERCENTAGE OF STANDARD PAYMENT late fee, the

standard payment amount was $500, and the account was due for $2000, then the late fee
will be $50 (10% of 500). In other words, every month the system computes the late fee using
monthly standard payment amount ($500), irrespective of the amount paid by the customer.

If the customer pays $400 out of $500, the system still computes the late fee using $500, and
not on $100.

FLAT AMOUNT PYRAMID LAW

FLAT AMOUNT PYRAMID LAW prevents the pyramiding of “flat” late fees. If an account is
overdue, then the system assesses a flat (fixed amount) late fee. However, if the standard
payment is made the following month, then a new late charge will not be created, even if the
payment made does not fulfill the current amount due.

For example, if a customer is assessed a late fee of $25 for 1/2005, and makes his $200
standard payment in 2/2005, that person cannot be assessed a new $25 late fee for 2/2005
(even though his payment only fulfilled the amount owed for 1/2005).

If a customer makes a payment of just $199 in 1/2005 (an amount that does not fulfill the
standard payment), then the customer could also be assessed a $25 late fee for 2/2005.

If the customer makes a payment of $199 in 2/2005 (an amount that does not fulfill the
standard payment), then the customer could be assessed a late fee for 2/2005.
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PERCENTAGE OF PAYMENT DUE PYRAMID LAW

PERCENTAGE OF PAYMENT DUE PYRAMID LAW prevents the pyramiding of “percentage of
payment due” late fees. If an account is overdue, then the system assesses a fee based on
what part of a payment remains to be paid. However, if the standard payment is made the
following month, then the system will not create a new late charge, even if the payment made
does not fulfill the current amount due.

For example, if the PERCENTAGE OF PAYMENT DUE PYRAMID LAW late fee is set as 10%,
and if only $90 of a $200 standard payment was due, then the late fee would be $9.

If $3000 on a loan with a standard payment of $200 was due, the late fee would be $20.
However, if a customer was assessed a late fee of $9 for 1/2005, and makes his $200
standard payment in 2/2005, then that person cannot be assessed a new late fee for 2/2005
(even though his payment only fulfilled the amount owed for 1/2005).

If the customer makes a payment of $199 in 2/2005 (an amount that does not fulfill the
standard payment), then the individual could be assessed a late fee for 2/2005.

Note

The system computes the late fee based on the payment due for only that month and not
the accumulated due amounts.

If the stated monthly payment is $300 and account is delinquent for 3 months ($900), then the
system computes the late fee every month with the amount due for that month ($300 or part
of $300) and not on $900.

PERCENTAGE OF STANDARD PAYMENT PYRAMID LAW

PERCENTAGE OF STANDARD PAYMENT PYRAMID LAW late fee prevents the pyramiding
of “percentage of standard payment” late fees. If an account becomes overdue, then the
system assesses a fee based on the standard monthly payment, regardless of the current
amount due. However, if the standard payment is made the following month, then the system
will not create a new late charge, even if the payment made does not fulfill the current amount
due.

For example, if the PERCENTAGE OF STANDARD PAYMENT PYRAMID LAW late fee is set
as 10%, and the standard payment is $200, then $20 (10% of 200) is owed. If only $90 of a
$200 standard payment was due, then the late fee would still be $20.

If $3000 on a loan with a standard payment of $200 is due, the late fee will be $20, since the
fee is calculated based on the payment due -- not the total outstanding amount due.

However, if a customer is assessed a late fee of $20 for 1/2005, and makes the $200 standard
payment in 2/2005, that person cannot be assessed a new late fee for 2/2005, even though
the payment only fulfills the amount owed for 1/2005. If the customer makes a payment of
$199 in 2/2005 (an amount that does not fulfill the standard payment), then the system could
assess a late fee for 2/2005.
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Appendix B: Rounding Amounts and Rate Attributes

Rounding Amounts

Generally in the lending industry, computed amounts (interest, fees, costs, and so on) are
rounded to the second decimal place. However, there are occasions where the rounding of
the computed amounts has to be carried out using different methods. Oracle Financial
Services Lending and Leasing supports the rounding, raising, or cutting off of calculated
amounts.

Rounding will increase the resulting amount to the next number up to the second decimal,
based on the value of third decimal.

Raising will always increase the resulting amount to the next number up to the second
decimal.

Cutting off will always cut the number after the second decimal.

You can choose the rounding method you want to use by setting the parameter value for the
system parameter CMN_AMOUNT _ROUND_METHOD on the Administration form (Setup
menu bar > Administration link > System link > System Parameters link > System tab).

You can choose the rounding factor you want to use by setting the parameter value for the
system parameter CMN_AMOUNT_ROUND_FACTOR on the Administration form. Currently,

the system supports rounding up to two decimals only.

Examples of how resulting amounts differ by RAISE, ROUND, and CUTOFF:

Example 1: Amount: 234.136

Method Result
Round 234.14
Raise 23414
Cutoff 234.13

Example 2: Amount: 234.134

Method Result
Round 234.13
Raise 234.14
Cutoff 234.13

Example 3: Amount: 234.1319999

Method Result
Round 234.13
Raise 234.14
Cutoff 234.13
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Note

The system rounds only calculated amounts (calculated fees, calculated payment, and so
on) and not user-entered amounts.

Rate Attributes

The system supports the rounding of the index rate to keep the rate calculation as simple as
possible for the customers. The general practice is to round the rate to nearest eighth (1/8th)
(to keep the index rate in the multiple of .125) or fourth (1/4th) (to keep the index rate in the
multiple of 25). The system rounds only the index rate and not the margin or final rate. You
can define the index rounding method on the Product tab’s Product Definition screen for
variable rate line of credits.

Note

Index rounding does not apply to fixed rate leases.

The system currently supports the following rounding of methods.

1. NO ROUNDING TO INDEX RATE
2. INDEX RATE ROUNDED TO NEAREST .25
3. INDEX RATE ROUNDED TO NEAREST .125

NO ROUNDING TO INDEX RATE: Select this method for no rounding.

INDEX RATE ROUNDED TO NEAREST .25: Select this method to round up to 1/4th (to keep
the index rate in the multiple of .25).

Examples
Current rate: 5.125

Round of rate: 5.25

Current rate: 5.124

Round of rate: 5.00

INDEX RATE ROUNDED TO NEAREST 0.125: Select this method to round up to 1/8th (to keep
the index rate in the multiple of 0.125).

Examples:
Current rate: 5.325

Rate rounded to: 5.375

Current rate: 5.312

Rate rounded to: 5.250
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